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Virtual Desktop Client Software 

 

Overview 
 
This manual provides installation and configuration instructions to end-users for a platform 
called “VMware Horizon.” The platform allows end-users to have remote access from a virtual 
or physical machine to physical equipment within a physical lab classroom at the college 
campus. 
 
The remote access provides the end-user with secure communication to the Centennial College 
lab environment by establishing a secure virtual tunnel to a physical or virtual machine inside 
the college, enabling the end-user to do coursework as if they are on-campus using physical 
classroom equipment. 
 
Depending on the course and the lab assignment, a student will need to select either access to 
the physical machine, which connects to other physical equipment for that lab assignment, or a 
virtual machine for a lab that doesn’t require physical access to the physical hardware. 
 
Please note that these instructions are provided for end-users (students) as a resource for self-
guided installation and configuration of personal devices. The college IT support (HelpDesk) 
cannot provide support for software installations or configuration of personal devices. Please 
do not contact the college HelpDesk with enquiries about the installation or configuration of 
your device. Students may contact the professor teaching the applicable course for assistance.  
The professor’s contact information is available in the eCentennial course shell. Students must 
contact the professor using their myCentennial e-mail address. Professors are prohibited from 
replying to mail from a personal e-mail address. 
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System Requirements for Windows Client Systems 
 
Horizon Client for Windows can be installed on PCs and laptops that use a supported Microsoft 
Windows operating system. The PC or laptop on which you install VMWare Horizon Client, and 
the peripherals it uses, must meet the following system requirements. 
 
Models: 
All x86 or x86-64 Windows devices 
 
Memory: 
At least 1 GB of RAM 
Operating systems 
 
Video and graphics requirements: 
Graphics card that supports Direct3D 11 Video. 
Latest video and graphics card drivers. 
For Windows 7 SP1, install the Platform update for Windows 7 SP1 and Windows Server 2008 
R2 SP1. For information, go to https://support.microsoft.com/en-us/kb/2670838. 
.NET Framework requirements 
 
The Horizon Client installer requires .NET Framework version 4.5 or later. The installer checks 
whether .NET Framework version 4.5 or later is installed before installation. The installer 
downloads the latest version of .NET Framework automatically, if the clients’ machine does not 
meet this prerequisite. 
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Horizon Windows Client Installation  

1. To access this platform, open a web browser, and go to: 
http://classapps.centennialcollege.ca/ 
For this installation, the recommended browsers are Chrome and Firefox.  
 

2. When the page loads, you will be presented with a choice between downloading and 
installing the VMWare Horizon Client or access via the HTML view (without having to 
install anything). For increased performance and features, install the VMWare Horizon 
Client (also called Horizon Client in this document) on your local computer. Installation 
details are found in the following steps. 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
  

 

http://classapps.centennialcollege.ca/
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3. If you choose to install the Horizon Client, scroll down to the bottom of the page where 
you can choose to install the client relevant to your computer as shown in the 
screenshot below. Click on one of the three Buttons based on your computer system, 
Windows, Mac, or Chrome OS. This will take you to the Download Product page.   

 
 
 

4. From the Download Product page, select the software version to download from the 
dropdown menu as shown in the screenshot below. It is recommended to download the 
latest version (5.4.3 at the time this document is prepared).    

 
 
 

5. Scroll down and click DOWNLOAD NOW. The client installer (For example: VMware-
Horizon-Client-y.y.y-xxxxxx.exe) will be downloaded. You may choose to copy the 
installer to your desktop or any other folder. 
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6. Double click the installer to proceed with the installation. Select "Agree & Install," from 
the pop-up window.   

 

 

 

 

 

 

 

 

7. Select Run then the new installation window appears.  See the screenshot below. 
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8. The installation will start with caching the software 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Then, the software needed to run the program will install.  
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10. When the program is installed, select, “Finish,” and, “Restart” your computer.  
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Starting VMware Horizon and Connecting to VDI Server 

 
1. You can now launch Horizon Client from the Start Menu. Once launched you need to 

add a server. Click New Server or double-click “Add Server” to add a new server. A 
small window will pop up as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. In the text field: Enter the name of the Connection Server, type: 
uag.centennialcollege.ca, to create the server. The page should resemble the 
screenshot below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

 
3. To connect to the VDI server, double click the icon of the uag.centennialcollege.ca or 

right-click on the icon and click Connect and the Login window will appear.  
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4. To Login and access a physical lab remotely, input your Active Directory username 

(ADID) and password. For students, the ADID is your student ID number. For 
employees, the ADID is the cencol domain name (do not use the employee number).  
 

 
 
 
 
 
 
 
 
 
 
 

 
 

5.  After logging in successfully, you should land on the home page of the VDI server. The 
home page will have icons for each physical classroom identified by room number. 
Double-click on the designated classroom for the appropriate course and you will then 
be connected to an available workstation in the classroom. Note: You will only see 
classrooms that apply to your courses. Contact your professor if you cannot locate 
the classroom for your course. 

 

 

 

 

 

 

 

IMPORTANT….IMPORTANT….IMPORTANT…..next page…. 
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When you are finished with your session, log-out. Do not shut 
down the remote computer.   

To log out, click Disconnect (or Log off then Disconnect) from the start menu of the remote 
Desktop. Alternatively, click Send Ctrl-Alt-Delete from the Options menu or the Taskbar shown 
below then select Log off. 

or 

 

 

 

 

 

Logging out will allow other students to use the remote computer. If you do not log-out, you 
will be automatically logged out of the computer after 10 minutes of being disconnected. For 
example, if you close the VMware Horizon Client. 

An automated message will be sent to you 10 minutes before a scheduled class ends that will 
state: 
Hello, this is an automated message from Centennial College. You are presently logged into a 
physical computer in lab #### at the Progress campus.  A class will be starting in 10 minutes 
that requires the use of the physical computers in lab ####.   You must save your work and log 
off in the next 10 minutes.  If you wish to continue working, please log-off from the remote 
physical computer and then log-in to the SETAS ICET Open Lab #1 VDI computer pods (or labs). 
There you will be able to access a virtual machine for as long as you require. Thank you for your 
cooperation. 
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Sharing Access to Local Folders and Drives with Client Drive Redirection 

Note: In the following procedure: 

 Local system refers to your local computer or desktop. 

 Local application/file/drive refers to application/file/drive in your local computer. 

 Remote system refers to the remote computer or desktop at the lab you are remotely 
connected with.  

 Remote application/file/drive refers to the application/file/drive available at the 
remote computer.   
 

You can use Horizon Client to share folders and drives on the local client system with remote 
desktops and applications. This feature is called “Client Drive Redirection.” 
 
Drives can include mapped drives and USB storage devices. Mapped drives can have Universal 
Naming Convention (UNC) paths. 
 
In a Windows remote desktop, shared folders and drives appear in the “This PC” folder, or, in 
the “Computer” folder, depending on the Windows operating system version. In a remote 
application, such as Notepad, you can browse and open a file in a shared folder or drive. 
 
You do not need to be connected to a remote desktop, or application, to configure Client Drive 
Redirection settings. The redirection settings apply to all remote desktops and applications. 
That is, you cannot configure the settings so that local client folders are shared with a selected 
remote desktop or application; the settings will apply to all remote desktops or applications. 
 
You can also turn on the ability to open local files with remote applications directly from the 
local file system. When you right-click a local file, the “Open With” menu also lists the available 
remote applications. You can also set files to be opened automatically with remote applications 
when you double-click the file. When you enable this feature, all files on your local file system 
that have certain file extensions are registered with the server that you are logged in to. For 
example, if Microsoft Word is one of the remote applications available from the server, you can 
right-click a .docx file on your local file system and open the file with the remote MS Word 
application. This feature requires Horizon 6.2 or later servers and agents. 
 
From your local computer you can save/transfer files to remote client computer lab. To enable 
or disable this access, follow the steps below:  
 

Procedure for Sharing Folders and Drives with Client Drive Redirection 
1. Start VMware Horizon Client from your local computer and connect to the VDI server using 

your College ADID as described in steps 2-4 of the previous section. 
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2. From the home page of the VDI server, click the Settings Button (the wheel button) on the 
top right corner. Navigate with the slide bar of the Sharing window and select   Sharing in 
the left panel. Make sure all the four checkboxes are checked. This procedure is 
demonstrated as 3 steps in the screenshot below.  
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Another option: Right-click a desktop or application icon, select Settings, and select 
Sharing in the left panel of the window that appears. 

 
 
Then at the Sharing window, click Add. The Browse For Folder window will pop up. 
Use the Browse For Folder window to browse your local computer drives and 
folders.    
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3. Select any drive, folder or subfolder to be shared then click   OK. The shared folder 
or drive will appear on the sharing window as shown below. Make sure the four 
checkboxes are checked. Click Apply then OK.   
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6. To remove the shared drive/folder/subfolder, simply click the Remove tab in the 
Sharing window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Refer to the table below for all options and actions available in the Client Drive 
Redirection feature. 

 

Option Action 

Share a specific folder or drive 
with remote desktops and 
applications 

Click the Add button, browse to and select the folder or drive to share, 
and click OK. 
Note: 
You cannot share a folder on a USB device if the device is already 
connected to a remote desktop or application with the USB redirection 
feature. 
 
Do not turn on the USB redirection feature that automatically connects 
USB devices at startup or when the device is inserted. If you do, the 
next time you start Horizon Client or plug in the USB device, the device 
will be connected using the USB redirection feature rather than the 
client drive redirection feature. 

Stop sharing a specific folder or 
drive 

Select the folder or drive in the Folder list and click the Remove button. 

Permit remote desktops and 
applications access to files in your 
local user directory 

Select the Share your local files user-name checkbox. 
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Option Action 

Share USB storage devices with 
remote desktops and applications 

Select the Allow access to removable storage checkbox. The client 
drive redirection feature automatically shares all USB storage devices 
inserted in your client system and all FireWire and Thunderbolt-
connected external drives. You do not need to select a specific device 
to share. 
 
Note: 
USB storage devices already connected to a remote desktop or 
application with the USB redirection feature are not shared. 
If this checkbox is deselected, you can use the USB redirection feature 
to connect USB storage devices to remote desktops and applications. 

Turn on the ability to open a local 
file with a remote application 
from the local file system 

Select the Open local files in the hosted applications checkbox. With 
this option, you can right-click a file in your local file system and select 
to open the file with a remote application. 
You can also change the properties of the file so that all files with that 
file extension are opened with the remote application by default, such 
as when you double-click the file. For example, you can right-click a file, 
select Properties, and click Change to select the remote application to 
open files of that type. 
Your administrator can disable this feature. 

Do not show the Sharing dialogue 
box when you connect to a 
remote desktop or application 

Select the Do not show dialogue when connecting to a desktop or 
application checkbox. 
If this checkbox is deselected, the Sharing dialogue box appears the 
first time you connect to a desktop or application after you connect to 
a server. For example, if you log in to a server and connect to a 
desktop, you see the Sharing dialogue box. If you then connect to 
another desktop or application, you do not see the dialogue box again. 
To see the dialogue box again, you must disconnect from the server 
and then log in again. 

 
 

Verification 

Verify that you can see the shared folders from within the remote desktop or application: 
From within a Windows remote desktop, open File Explorer and look in the This PC folder, 
or open Windows Explorer and look in the Computer folder. 
From within a remote application, if applicable, select File > Open or File > Save As and 
navigate to the folder or drive. 
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The folders and drives that you selected for sharing might use one or more of the following 
naming conventions: 

 name on MACHINE-NAME. For example, jsmith on JSMITH-W03. 
 N on MACHINE-NAME. For example, Z on JSMITH-W03. 
 name (N:). For example, jsmith (Z:). 

A redirected folder can have two entrances, such as Z on JSMITH-W03 and jsmith (Z:) and 
both entrances can appear at the same time. If all the volume labels (from A: through Z:) are 
already in use, the redirected folder has only one entrance, such as Z on JSMITH-W03. 

 

Troubleshooting Horizon Client 
 
You can resolve most problems with Horizon Client by restarting or resetting the desktop, or by 

reinstalling the VMware Horizon Client application. 

 Restart a Remote Desktop 

You might need to restart a remote desktop if the desktop operating system stops 

responding. Restarting a remote desktop is the equivalent of the Windows operating 
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system restart command. The desktop operating system usually prompts you to save 

any unsaved data before it restarts.   

 Reset a Remote Desktop or Remote Applications 

You might need to reset a remote desktop if the desktop operating system stops 

responding and restarting the remote desktop does not solve the problem. Resetting 

remote applications quits all open applications.   

 Repair Horizon Client for Windows 

Sometimes you can resolve problems with Horizon Client by repairing the Horizon 

Client application.  

 Horizon Client Might Exit Unexpectedly 

Horizon Client might exit even if you do not close it. Depending on your Connection 

Server configuration, you might see a message such as, “There is no secure connection 

to the View Connection Server.” In some cases, no message is displayed. This problem 

occurs when the connection to the Connection Server is lost. To solve this problem, 

restart Horizon Client. You can connect successfully as soon as the Connection Server is 

running again. If you continue to have connection problems for more than 5 minutes, 

you will need to determine if the connectivity failure is a local or college service 

interruption such as internet or power service. 

 For local service interruptions: Students must note the day and time of the 

connectivity failure and contact the applicable service provider for verification of 

the service interruption period. If you experience a local service interruption 

during a lab exercise or a quiz or test, you may be required to provide the 

verification to your professor for approval of make-up work or extended 

deadlines. As soon as the service resumes, you must notify the professor (by e-

mail) of the interruption and make arrangements to complete any missed work. 

 For service interruptions from the college: When services are disconnected at 

the college level, the professor and all students will experience the interruption 

at the same time. The professor will contact appropriate support at the college 

and will post recovery instructions in the eCentennial course shell. Students 

should check the course shell frequently for the remainder of the class period 

and follow the instructions to resume coursework. If the interruption extends to 

beyond the end of the class period, students should check eCentennial for 

announcements regularly (every day) until recovery instructions are posted. 

 

 Uninstall Horizon Client for Windows 

You might need to uninstall and reinstall Horizon Client if repairing Horizon Client does 

not resolve the problem.  To uninstall: 

 Verify that you can log in as an administrator on the client system. 
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 The following procedure shows you how to uninstall Horizon Client if you have 

the Horizon Client installer:  

 To uninstall Horizon Client interactively, double-click the Horizon Client 

installer, or run the Horizon Client installer with the /uninstall installation 

command from the command line, and click Remove. To uninstall 

Horizon Client silently, run the Horizon Client installer with the /silent and 

/uninstall installation commands from the command line. For example: 

VMware-Horizon-Client-y.y.y-xxxxxx.exe /silent /uninstall 

 If you do not have the Horizon Client installer, you can uninstall Horizon Client in 

the same way that you uninstall other applications on your Windows system. For 

example, you can use the Windows operating system Add or Remove Programs 

feature to uninstall Horizon Client. 

 Problems with Keyboard Input 

If you type in a remote desktop or application and none of the keystrokes work, or, a 

single key keeps repeating itself, the issue might be with security software on your local 

client system. Some security software, such as Norton 360 Total Security, includes a 

feature that detects keylogger programs and blocks keystroke logging. This security 

feature is meant to protect the system against unwanted spyware that, for example, 

steals passwords and credit card numbers. Unfortunately, this security software might 

block Horizon Client from sending keystrokes to the remote desktop or application. To 

solve: On the client system, turn off the keylogger detection feature of your antivirus or 

security software.   

REMINDER:When you are finished with your session, log-out. Do not shut 
down the computer. 

This will allow other students to use the computer. If you do not log-out, you will be 
automatically logged out of the computer after 10 minutes of being disconnected. For 
example, if you close the VMware Horizon Client. 

Appendix 

Fall 2020 ICET Course List and Course Section Numbers (tba) 

The designated classroom room numbers correspond with the professor/student timetable in 
myCentennial. To connect to the appropriate classroom, you must select the classroom 
assigned in your timetable. If you do not know the classroom number, contact the professor as 
noted in the eCentennial course shell. 

 


